Initial configuration
Vega 50 6x4 FXO
(SIP) -r7s5

“egas“ea\“

This document describes how to configure the FXO ports on a Vega 50 6x4 gateway using the
web browser interface. The configuration described will allow the Vega to be rapidly installed and
tested.

The instructions below will configure the Vega 50 6x4 FXO fail over ports for connection to the
PSTN, and the main FXO ports for connection to the extension ports of a PBX (or to the PSTN).
Calls through the Vega will operate as follows:

e Calls presented to the Vega FXO ports will be passed to the SIP proxy with the numeric
telephone number part of the request URI containing the port ID on which the call was
received (0201 .. 02nn).

e Calls received by the Vega on the SIP interface will be routed to one of the telephony
interfaces. The physical interface over which the call is routed will be defined by the
leading four digits of the telephone number (0201 .. 02nn). The digits following the leading
four digits will be used as the digits to dial.

SIF Proxy Foh |
one

LAN

Although the Vega 50 6x4 supports two LAN interfaces, in this example configuration, only one
LAN interface, LAN 1 will be used.
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Notes are included describing the changes required if there is no SIP proxy in the installation and
calls are to be routed to a specific destination device.

The configuration process is broken down into 12 stages as follows:

Connect your Vega to LAN, Telephone and Power
Configure the basic LAN parameters

Configure password and login timeout

Check and configure LAN settings and Host name
Configure the Dial Plan

Configure SIP parameters

Configure audio parameters

Configure Authentication

Configure Registration

10 Configure POTS parameters

11 Save Changes

12  Archive Vega Configuration

O©CoO~NOOOTA,WNPE

Please also see:
13 Technical Support
14  Advanced configuration
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1. Connect your Vega to LAN, Telephone and Power

| =R

Fower Switch

RJ21
Amphenal
Telco 50

AC Power

— FAO port 8, IF:0208
— FxO paort 1, IF:0201

Before installing your Vega, ensure that you read the VegaStream VoIP Gateways Safety
and Compliance Information document.

LAN:

Using the yellow booted cable(s) connect the LAN port(s) on the Vega to a standard or fast
Ethernet hub or switch (10 baseT or 100 baseTx). The connector nearest the ferrite core should
be plugged into the Vega.

For this configuration just connect the LAN 1 interface to the hub or switch.

If both LAN interfaces, LAN 1 and LAN 2 are to be used, the interfaces
must be on separate subnets.

WARNING!

Telephony:

The connector locations at which the FXO telephone ports are available, depends upon where in
the Vega the FXO interface cards are plugged. If an FXO card is plugged into interface slot 1 FXO
ports will be available on the RJ45 connector at locations IF 1 to IF 4 and on the RJ21 / Amphenol
/ Telco 50 connector. With an FXO card plugged into interface slot 2, FXO ports will be available
on the RJ45 connector at locations IF 5 to IF 8 and on the RJ21 / Amphenol / Telco 50 connector.
With FXO card(s) plugged into interface slots 3 to 6, these FXO ports will be available on the RJ21
/ Amphenol / Telco 50 connector only.

Note the port numbers on the RJ45 connector block increase in an anticlockwise direction from the
bottom left corner.

IF8 IF7 IF 6 IF5
IF:0208 | IF:0207 | IF:0206 | IF:0205
IF1 IF2 IF3 IF4
IF:0201 | IF:0202 | IF:0203 | IF:0204

See the ‘Vega 50 6x4 product details’ document for pinouts and cabling.
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When BRI ports are fitted, two of the four BRI signals are brought out
to the associated RJ21 / Amphenol / Telco 50 connector pins. In this
situation DO NOT connect anything to these pins on the RJ21 /
Amphenol / Telco 50 connector.

WARNING!

Power:
Insert the power cable into the AC power inlet on the Vega and switch on. The power LED on the
front panel will illuminate.

The LAN LEDs will also illuminate indicating 10 (baseT) or 100 (baseTx) connection. The LAN
LEDs are duplicated on the front and rear of the Vega. The LEDs blink off to indicate LAN activity.

After a short while the Vega Ready LED will illuminate — the Vega is ready to be configured.
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2. Configure the basic LAN parameters

If a DHCP server is available, by default, the Vega will automatically pick up an IP address. If you
know the IP address served to the Vega, skip this section and start at section 3.

If DHCP is not to be used to provide the Vega with an IP address, or you need to check the IP
address provided to the Vega, connect the serial interface of the Vega to a PC serial interface
using the supplied RJ45 to 9 way female D-Type connector cable.

Configure a terminal emulator program (such as Microsoft's HyperTerminal) for:

e Speed = 115200 baud
e Data bits =8

o Parity = none

e Stop bits =1

e Flow Control = none

Press <Enter> to get the Username: prompt

At the prompts enter the default user name and password
Username: admin
Password: admin

If this is your first login you will be presented with the opportunity to select the firmware to run (SIP
or H.323):

CHANGE ACTIVE PARTITION:

Partition 1: H.323 Firmware
Version: 11.01.07.5
Image: VEGA56x4 R075H00la Sep 16 2005 10:42:57

Partition 2: SIP Firmware (ACTIVE)
Version: 11.02.07.5
Image: VEGA-6x4 R075S001 Nov 25 2005 11:38:45

Type PART1 to activate partition 1, or EXIT to leave unchanged.

» Ensure that the partition marked as ACTIVE is the SIP partition, if it is not, then select the
other partition as instructed and reboot the Vega®.

> If the SIP partition is already marked as ACTIVE, then type EXIT

Once the firmware has been selected and activated, from the command prompt, display the
current IP address by typing:

show lan.if.1.ip

L If the partition is changed, after the reboot perform a “factory reset’ before continuing configuration.
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If this is not the IP address required, it can be overridden, together with other LAN parameters by

typing:

set
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save
reboot system

lan.
lan.
lan.
lan.
sip.

if.1l.use dhcp=0
if.1l.ip=aaa.bbb.ccc.ddd
if.1.subnet=eee.fff.ggg.hhh
gateway.ip=iii.jjj.kkk.111
lan profile=1
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3. Configure password and login timeout

Now configuration will be carried out via a web browser.

» Enter the IP address of the Vega into the “Address” field of your web browser.

2l VolP Gateway Online Configuration - Microsoft Internet Explorer E|

File Edit View Favorites Tools  Help .',"
Qeack -~ O - [¥] [&) @0 P search TrFavorites 8 - @ - @ 3
address |ﬁ 1?2.19.1@ v| Go
You will then be presented with the login page:
<} YolP Gateway Online Configuration - Microsoft Internet Explorer |Z||§|fz|
File Edit Wew Favorites Tools  Help .".'
Qeack = ) - [#] [&) | P ssarch FeFavorites 8 (- &b -0 @ 3
Address | €] 172.19.1.99 v| B co
HostMame  this_hosthame
2
ress 181
eggﬁwe IP Add 172.19.1.99
IP Address 0.0.00
Leogin
Enter Username and Password
Llsernarme (1],\ >|
Passward (1,\ )'
Enter the default Username and Password
»Username:  admin
» Password: admin
> Select
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If you have not already selected the firmware to run (SIP or H.323) the boot manager will
automatically be displayed allowing you to select the code to run, SIP or H.323.

Boot Manager
Please check the current active firrmware version below, and select a different partition if reguired.

If & new partition is selected then a reboot systern will be needed to activate that wersion.

Change Active Partition
H.323 Yersion: 11.01.07 .5

O Paition 1| VEGASGxd_ROTSHD1a Sep 16 2005 10-42:57
- SIP Yersion: 11.02.07 .5

© Paition2 | o VEGABxd RO75S001 Nov 25 2005 11:38:45

Continue ..

» Ensure that the partition selected is the SIP partition, if it is not, then select it

> Press Confinue ..

If the partition is changed then the Vega will automatically reboot; in this case you will need to log
in again once the reboot is complete?.

If the partition is not changed then the management page will be displayed.

2 If the partition is changed, after the reboot perform a “factory reset’ before continuing configuration.
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| Vega 50 6x4 Online Configuration - Microsoft Internet Explorer

=]

X

File Edit ‘Wew Favorites Tools Help |';
QBack = ) - [ [2] (» S search 7 Favorites ) ~ i = 3
Address |g“| http:/{172.19.1,99)vsframe7sid=-1364306751 &frame_id=6 v| Go

Host Mame  this_hostname
geam IP Address 172.158.1.99

Ned® IP Address  0.0.0.0

UzerMame  admin

Ead Ead
Management < | System Management |
Loggin
Maintenance Tip: Place the cursor of the mouse on name or input fields to get concise help.
LAN
POTS System Time
Dial Plan _ -
DSP Set Time (hhemm:ss) 12 |03 |- 28 |
Media Set Date (ddimmiyyyy) |23 |; 02 |y [2006 |
Tones Synchronise Ti dD

ynchronise Time and Date Wyith PC

stp ?

O With NTP server

Users

QoS Statistics B
Supp.Services Call Repotts

Advanced Report call progress summary Show Calls

Report on all call progress statistics Show Trace

System Logs

Show the Event Log Show Event Log
Shaow the Billing Log Show Billing Log
-
o EEEEN
¢ [ Allfurther calls are Unblocked + Z
@Done  Internet

» On the left hand side menu select Users
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Yega 50 6x4 Online Configuration - Microsoft Internet Explorer |Z||E|E|
File Edit “iew Favorites Tools  Help -#
Qeak - O - [® [2] | O seach 57 Favorites € - da = 3
Address |$§| http:ff172.19,1.62 fvsframe?sid=183210002&Frame _jd=27 V| Go GDEngE - | e |”

Host Kame  this_hostname
sgea‘“ IP Address 172.19.1.62
ved IP Address  0.0.0.0
UserMame  admin
M s
Management | Users 1
Loggin
Maintenance Administrater
LAN Logging
DSL Billing (I
POTS
ZUTap>
Dial Plan Frompt 1R |
DSP Remote Access
Media Timeout 240 ) |
S|P
Users “ Administrator Password
()
e Mew Password < D
Supp.Services
Advanced Re-enter Password q\ J
(EE0)
| p—
oG o
Logaing o]
.
7 Billing
< | 8 Promit |%uzen> 4
@ httpe/f172.19. 1. 62 v sframersid=1639100028frame_id=27 ® Internet

Recommended: Change the password
» enter New Password and Re-enter Password then

> select Ml and then click “here” to return

Optional: Change the timeout® — default is 240 seconds; can extend to 7200 seconds (2hrs)

> select Ml and then click “here” to return

% If the web interface is not used for this length of time the VVega will automatically log off the session. This change is
only activated by logging out and back into the browser session.
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4. Check and configure LAN settings and Host name
» On the left hand side menu select LAN

Yega 50 6x4 Online Configuration - Microsoft Internet Explorer E|@|g|
File Edit \iew Favorites Tools Help !,’
Qoak - O - 5 A o ) search <% Favorites  42) LY -

Address |g"| http:if172.19.1,99)vsframe?sid=7562315188frame_id=1 v | Go

HostMame  this_hosthame

s“eam IP Address  172.19.1.99
yed? IP Address  0.0.0.0

Uger Name  admin
& Ungaved Configuration Changes

| Local Area Network (changed) 25
Managyement
Loggin Warning: Changing these parameters may prevent remote access.
Maintenance
LAN 4 LAN Configuration
POTS Marme |this_h05tname
Dial Plan
DSP
Media
Tones LAN Configuration
sip LA | LAN 2
sers © DHCP © DHCP
QoS Statistics
Supp.Services O Static: ) Static

Advanced IP Address

bt Mask Subnet sl 252552550 |
Configure LAN Interface
. -
QoS | TOS/DiffSens v| QoS | TOS/DiftSens v
Accept non 80214 Accept non 80214
tagged frames tagged frames
P re QO3 Profiles
< 5 Submit v
& B Internet

In this configuration scenario we are just going to use LAN interface 1, so in the next steps we will
configure the parameters required for LAN interface 1, configuring both calls and management
traffic to be routed via this LAN interface.

» Ensure that the IP address and subnet mask are configured correctly.
With DHCP enabled the current values collected by DHCP are shown ‘greyed out’

» If static configuration of the IP information is required select ‘Static IP Address’ and
configure the values as required.

» If changed select M and then click “here” to return; return to LAN Interface 1
configuration page.
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LAN Configuration

LAN 1 | LAN 2
®DHCP ®DHCP
O Static O Static
IP Address IP Address
Subnet-hask Subnet Mask
Configure LAN Interfaces
Cos TOS/DiffSer v | QoS TOS/DiffSery v
Accept non 80214 Accept non 80214
tagged frarmes tagged frames
Configure Q05 Profiles

In the LAN configuration section
» Select Configure LAN Interfaces

LAM Configuration

LAN 1 | LAN 2 |
Physical Layer Physical Layer

Enahle Full Duplex OJ Enable Full Duplex O
Enable 10baseT [w] Enable 10baseT
Enable 100baseT [w] Enable 100baseTX

Recommended: In the Physical Layer section for LAN 1, leave ticked only 100baseTx or 10
baseT (not both) — whichever is appropriate (this ensures that any re-negotiation of the LAN
connection bandwidth will always result in the same connection rate)

Optional: In the Physical Layer section for LAN 1, tick ‘Full Duplex’ to allow the Vega to attempt
to negotiate a full duplex LAN connection (this gives increased bandwidth on the LAN link)

> select M and then click “here” to return

If you are planning to use LAN interface 2 — check its configuration too.

If both LAN interfaces, LAN 1 and LAN 2 are to be used, the interfaces
must be on separate subnets.

WARNING!

Now continue configuring the other LAN parameters:

LAM Cenfiguration

Marme this_hosthame

kSubmit_J
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If the Vega has a DNS name associated with its IP address, in the LAN Configuration section
» set Name = the DNS name

> select Ml and then click “here” to return

» Scroll down to the Default LAN Gateway section

Default LAN Gateway |

LAN Gateway [P Address

& DHCP

From DHCP server on LAN interface 1-LANT (v

) Static
IP Address

Submit |

Optional: If Static addressing is to be used to define the LAN gateway

» Select Static IP Address
» Set up the LAN Gateway IP address either as a DNS name or as a dotted decimal IP

address.
> Selectﬂl and then click “here” to return

» Scroll down to the Calls section

Calls
LAM Profila 1-LAM_1 A

Submit ]

» Ensure that the LAN profile is 1-LAN_1
» If it needs changing, change it, then selectﬂl and then click “here” to return

> Scroll to the TFTP Parameters section

TFTP Parameters |

TFTF Server IP Address

®DHCP

Frorm DHCP server on LAM interface TLANT v
O Static

TFTP Server IP Address
LAN Profile T-LAMN_1 w

Configure TETP
L Submit‘
Optional: If Static addressing is to be used to define the TFTP Server
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YV V VYV

>

Select Static TFTP Server IP Address

Set up the TFTP Server IP address either as a DNS name or as a dotted decimal IP
address.

Ensure that the LAN profile is 1-LAN_1

SelectMl and then click “here” to return

Scroll to the NTP Parameters section

NTP Parameters |

NTP Server IP Address

®DHCP

Frorm DHCF server on LAN interface 1-LANT v

O)Static

NTP Server IP Address

LAN Profile

1-LAN_T

Configure MTP

Submit‘

Set up NTP to get time updates for the real time clock — this keeps the clock accurate over long
periods of time.

Optional: If Static addressing is to be used to define the NTP Server

>
>
>
>

>

Select Static NTP Server IP Address

Set up the NTP Server IP address either as a DNS name or as a dotted decimal IP
address.

Ensure that the LAN profile is 1-LAN_1

Selectﬂl and then click “here” to return

Scroll to the Ping, SNMP, Radius etc section

Ping, SNMP, Radius etc

LAMN Profile

kSubmit‘

1-LAN_T

» Ensure that the LAN profile is 1-LAN_1

» If it needs changing, change it, then selectﬂl and then click “here” to return
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> Scroll to the DNS Servers section

DNS
DNS Server List 1721911 »
Use ONS Server defined by K
DHCF on Lan Interface 11ANT
 Subrrit |
Static DNS Servers
DNS Server Domain Name Server
1 0.0.0.0
2 0.0.0.0
3 0.0.0.0

Submit | Add | Delete

DNS servers will be set up using both DHCP served DNS servers and also static DNS Servers
specified here.

» Ensure Use DNS Server defined by DHCP on LAN Interface = 1-LAN 1

» If it needs changing, change it, then selectﬂl and then click “here” to return

Optional: If static DNS servers are to be defined, in the Static DNS Servers section

» Set up Domain Name Server IP address(es) (Press Add | if more than 3 static entries
are required)

» Select Ml and then click “here” to return

(Note, the DHCP supplied DNS server will be used in preference to statically defined servers,
unless the DHCP defined server is also statically defined, when the static order will be used.)

» Scroll to the Management Access section

Management Access
LANProfile LAN Port
Telnet FLAN_T182 # 23
Wieh Server FFLAMN_T&Z2 » a0
» Submit_J

» Set Telnet LAN Profile =1-LAN_1
» Set Web Server LAN Profile = 1-LAN_1

> Select M and then click “here” to return
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5. Configure the Dial Plan

» On the left hand side menu select Dial Plan

ega 300 6x4 Online Configunation - Microsoft Internet Explorer,

:I
/3

File Edit Yiew Favorites Tools  Help :,
@Back - ) - [¥ [ (» ) search o7 Favorites £ ~ @ 3
address |ﬂj hkkp: /172,19, 1,99 vsframe?sid=-15353635408f rame_id=35 v| &0
HostMame  this_hostnarme
aﬁ\ IP Address 172.19.1.99
q@?s“e IP Address  0.0.0.0
UserMame  admin
/i\, Unsaved Configuration Changes
Ay Ay
Management Dial Planner
Loggin
Maintenance Profiles
LAN Del? Prafile 1D Enabled MName Plans Chg?
POTS i 1 1 default =3
Dial Plan « | _Delete | Add |
DSP
Media Post Profile
Tones Enabled D
sie
Users
QoS Statistics Plans in Post Profile
Supp.Services Del? Plan IV Enable Name Srce Dest Chg?
Advanced O 1 ] International TEL:00<.*>= TYPE:international hlodify
Delete | Add B
Planner Groups
Del? ID Mame  Cause Lan  Active times Friarity Chyg?
i 0 1 default 1] off 0000-2359 0 Iodify
Delete | Add
T
3 | 3 Call Presentation Groups Configuration v
@ ® Internat
In the Profiles section, Profile ID 1
> Select Modify
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Dial Planner > Profile 1

Modify Profile
Profile ID 1
Enabled
MNarne |default
Submit
Plans in this Profile
Del? F‘llDan Mame Sroe Dest Cost Group Chg?
[0 1 outgoing_lan IF:0[1-4].. TEL:<.*> IF:2901 TEL:<1> 0O 1 hodify
[0 2 incoming lan IF:9301 TEL <. =< *> |F:<1=TEL<2> 0O 1 Modify
Delete Add
» SetName = Outbound to LAN
Submit S« "
» select 4| and then click “here” to return
Dial Planner
Profiles
Del?  Profile 1D Enabled Name Plans  Chg?
IF 1 1 Outbound_to_LAM === (_ Muodify
Delete Add
In the Profiles section, on Profile ID 1:
> Select Modify
Dial Planner > Profile 1
Modify Profile
Profile 1D 1
Enabled
Marme Outhound_to_LARM
Plans in this Profile
Del? F'llDan Name Sree Dest Cost Group Chg?
[0 1  outgoing lan IF:0[1-4].. TEL:<.*> IF:2901 TEL:=1> O 1 Modify
[1) 2 incoming_lan IF:9901 TEL:<.. =<*> IF:<1>TEL:<2> O 1 Modify

Delete ) Add

In the Plans in this Profile section:

» Tick the Del? Tick box against Plan ID 2
> Select Delete |
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Microsoft Internet Explorer [‘5__<|

9P

\_‘_..\/ Delete selected plans 7

[ ok i [ Cancel

> Select L

Dial Planner » Profile 1

Modify Profile
Profile 1D 1

Enabled

Mame |Outb0und_to_LAN

Plans in this Profile
Del? Plan 1D MName Srce Dest

Cost Group Chg?
1 1 outgaing_lan IF:0[1-4].. TEL:<."> [F:9301 TEL:<1> 0O 1
Delete | Add

In the Plans in this Profile section, Plan ID 1:
> Select Modify

Version 0.6 16 November 2006

Page 18 of 51
For use with Vega 50 6x4 FXO — SIP version 11.02.07.5_S011 or greater.

© 2006 VegaStream Ltd.



Yepa 500 6x4 Online Configunation - Microsoft Internet Explorer, [ZHEIEI
i

File Edit Yiew Favorites Tools  Help :;
@Back - ) - [¥ [ (» ) search o7 Favorites £ - ® 3
Address |ﬂj hkkp: /172,19, 1,990 vsframe?sid=-13353635408f rame_id=36 "| Go

HostMame  this_hosthame
IP Address 172.19.1.98

IP Address no.oan

User Name  admin

/i\, Unsaved & Unapplied Changes

art
qe'?s“e

2 Ea
Management | Dial Planner > Profile 1 > Plan1
Logygin
Maintenance Medify Plan
LAN Plan ID 1
POTS Profile D 1

Dial Plan < Mame Uoutgaing_lan |
psp Source IFoN-4) TEL<™" O |

Media Destination "F:9301,TEL<1>" O |
Tones
sip Cost Index |IJ |

QoS Statistics [ Generate Prefix katch ]

Users Grou C[E—default v P
([Appty )

1%l

upp.Services

Regular Expressions for Source
Any character

Supp.Services
Advanced
[...] Any character within the parentheses
[x-¥] Any character in the range x-y
[*..] Any character except those within the parentheses
N & The character before repeated zero or more times
+ The characterfexpression before repeated one or more times
= 7 The characterfexpression before repeated zero or moare times
< = The character following is taken literally Z
@ ® Internat

» SetName = From _any FXO port

» SetSource =IF:<02..> (This takes a call from any of the FXO
ports, 0201 to 0224, and stores the 4 digit
interface ID of the port on which the call
arrived in store <1>)

» Set Destination = IF:9901, TEL:<1> (This routes the call to IF:9901 (the LAN)
and passes the Interface ID of the port that
the call arrived on as the destination
telephone number)

» SetGroup=0 - no group

> selectﬂl and then click “here” to return
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2} Yega 50 x4 Online Configuration - Microsoft Internet Exploren

File Edit Yiew Favorites Tools  Help -:,'
@Back - ) - [ [ (» D search St Favorites 88 0+ L @ 3
address |@ hkkp: /172,19, 1,990 vsframe?sid=-13353635408f rame_id=36 v| &0
HostMame  this_hostnarme
l_‘.e IP Address 172.19.1.99
yed? IF Address  0.0.0.0
User Name  admin
/i\, Unsaved Configuration Changes
A
Management Dial Planner > Profile 1
Logygin
Maintenance Modify Profile
LAN Prafile 1D 1
POTS Enabled
4 pial Plan> | Mame Outhound_to_LAN
Media
Tones Plans in this Profile
SIp Del? Plan ID MName Srce Dest Cost Group Chg?
Users IFI 1 From_any FXO _port IF:<02 > IF:9901 TEL<1> O 0 Modify
QoS Statistics Delete | Add
Supp.Services
Advanced 5) |
J
b
< | =
@ ® Internat
»On the left hand side menu select Dial Plan
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2l Yega 50 6xd4 Online Configuration - Microsoft Internet Explorer,

File Edit Yiew Favorites Tools  Help :,'
QBack - ) ¥ 2] (0 S search T Faverites € ~ i T §
address |ﬂj hkkp: /172,19, 1,99 vsframe?sid=-15353635408f rame_id=35 v| &0
Host Matme  this_hosthame
l_re IP Address 172.19.1.99
yed? IF Address  0.0.0.0
User Name  admin
/i\, Unsaved & Unapplied Changes
Ea Ea
Management Dial Planner
Logygin
Maintenance Profiles
LAN Del?  Profile I Enabled MNarme Flans  Chg?
POTS IF 1 1 Outhound _to_ LAMN ===: Idodify
Dial Plan - Delete
DSP
Media Post Profile
Tones Enabled D
sie
Users
QoS Statistics Plans in Post Profile
Supp.Services Del? Plan ID Enable MNarme Srce Dest Chg?
Advanced O 1 ] International TEL:00<.*>= TYPE:international hlodify
Delete | Add
Planner Groups
Del? ID Mame  Cause Lan  Active times Friarity Chyg?
[0 1 default 0 off 0000-2359 0 Iodify
Delete | Add
b’
< » Call Presentation Groups Configuration v
@ ® Internat

Now create a new profile and in it create a dial plan entry to handle calls being received inbound
from the LAN:

In the Profiles section
> Select Add |

In a similar manner to configuring Profile ID 1, configure Profile ID 2

In the Modify Profile section
» SetName = Inbound from LAN

Modify the first plan for Profile 2:
» SetName = To FXO ports
» SetSource =IF:99..,TEL:<02..><.*> (For calls from IF:99xx (LAN), take the first
four digits presented and store them in
store <1>; take any further digits and store
them in store <2>)
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» Set Destination = IF:<1>,TEL:<2> (The first four digits presented define the
interface — 0201 to 0224 — and the
remainder of the digits are passed on as
the telephone number)

> selectﬂl and then click “here” to return

Plans in this Profile

Del? F'llgn Name Srece Dest Cost Group Chg?

[0 1 To_FXO_ports IF:2901 TEL:<02.. >« *= |F:<1> TEL:<2> O 0 Modify
Delete | Add

Note: The SIP Proxy must choose the appropriate interface on the Vega to dial out from;
when the Proxy presents a call to the Vega, the INVITE message starts something like:

INVITE sip:02021344784900@172.19.1.99 SIP/2.0

The digits preceding the @ (the telephone number field) must contain 02xxttt...t, where
ttt...t is the telephone number to dial and 02xx is the FXO Interface from which to make
the call.

If the Proxy does not want to decide which FXO interface to route the call out from, but let the
Vega find a free port, this can be implemented. See 14.3 “Configure Veqga to dial out from a
free FXO port” for details.

For more details on the operation of the dial planner, including the various tokens
that may be used, see the section “The Dial Planner” in the Vega Primer.

Standalone / non-proxy installations: Where a proxy is not used add a TA: token to dial plans
that send calls to VolIP (i.e. to IF:9901), e.g. if the destination device is at IP address
192.168.1.54 then the dial plans above become:

Profile 1 plan 1 (change to ‘Destination’):
» SetName = From _any FXO port
» SetSource =IF:<02..>
» Set Destination = IF: 9901, TEL:<1>,TA:192.168.1.54
» SetGroup=0 - no group

Profile 2 plan 1 (no differences from above):
» SetName = To FXO ports
» SetSource =IF:99..,TEL:<02..><.%*>
» Set Destination = IF:<1>,TEL:<2>
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6. Configure SIP parameters

Note: everything in this section, except the configuration of ‘accept non proxy invites’ should be
skipped for Standalone / non-proxy installations

» On the left hand side menu select SIP

A Vega 50 6x4 Online Configuration - Microsoft Internet Explorer |
File Edit Yiew Favorites Tools Help :,'

Qeak ~ O - [# [@ @0 P search P Favorites € - i = 3
Address |ﬁ§] hktp: 172,19, 1,99 vsframe?sid=- 183536 3540&f rame_jd=52 v| G0
Hosthame  this_hosthame
IP Address 172.19.1.99
IP Address 0.0.0.0
UserMame  admin
& Unsaved Configuration Changes
-~ s
Management SIP Configuration
Logygin
Maintenance General
LAN Local Domain abcdefghijwhatevwl)
POTS Local SIP Port ROGD
Dial Plan
DSP Request LRI Port 5060
Media Accept Mon-Proxy Invites @
Tones LAN prafile
sie ()
Users
QoS Statistics SIP Profiles
Supp.Semvices
SIP Alternative Local P P T
Advanced Profile Diamain Header Header Header Chg?
‘ugerinfo’  ‘'host'  host'
= 1 abcdefghijwhatever. com Gl Luca_l Loca! kd odify
’ Party  Domain Domain
dd] Deete.
Proxy Configuration
Mode @®normal O cyclic
\ O dnssry
p > was - D000 = - w*
@ Done 0 Internet

In the General section:
> setlLocal Domain= Public name of proxy used by other devices to sen
d their INVITEs to
(this value is the “outside world’s” name or IP address for the proxy)

Optional: To allow devices other than the proxy to make calls directly through the Vega
» tick Accept Non-Proxy Invites

If only the proxy is allowed to route SIP calls through the Vega ensure that this tick box is clear.

Version 0.6 16 November 2006 Page 23 of 51
For use with Vega 50 6x4 FXO — SIP version 11.02.07.5_S011 or greater. © 2006 VegaStream Ltd.



> select M and then click “here” to return

» Scroll down to the Proxy Configuration section

Proxy Configuration

Mode @®normal O cyelic
O dnssn
Minimum *alid Response 180
Timeout (ms) h000
SIP Proxy Enable IP/ONS Name Port Chg?
1 0 0.0.0.0 5060 (_ todify.
Add | Delete

In the Proxy Configuration section, for SIP Proxy 1
> Select Modify

SIP > SIP Proxy 1

SIP Proxy 1
Enable [Fl
IP/DMS Mame  ([0.0.0.0
Part 50D
In the SIP Proxy 1 section:
» Tick Enable
» setIP/DNS Name= IP address of SIP proxy, Of

DNS hostname of the SIP Proxy

select M and then click “here” to return
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7. Configure audio parameters

The availability and priority of codecs offered and accepted by the Vega 50 6x4 is defined
by Media Capability Sets.

> On the left hand side menu select Media

A Yega 50 6x4 Online Configuration - Microsoft Internet Explorer

ﬁ|
4:

File Edit Yiew Favorites Tools Help
() Back - ¥ [ @m O search 5% Favorites ) - i = 3
Address féj hktp: /172,19, 1,99 vsFrame?sid=- 183536 3540&Frame_id=100 b . G0
HostMame  this_hosthame
'.Te IP Address 172.19.1.99
Ned? IP Address  0.0.00
UserMame  admin
& Unsaved & Unapplied Changes
- ~
Management Media
Loggin
Maintenance Media Control Profiles Configuration
LAN Iedia Control Profiles
POTS
Dial Plan Media Capability Sets
DSP Capability Set Marme Capability Indices  Chg?
Media o 1 yaice 1623 wlndif
Tones 2 voice-+H380dp 16236585 M
3 g/ 11faxmodem 8.3 dodify
sip Add | Delete
Users
QoS Statistics Media Capability
Supp.Services Capability Codec Codec Profile Chg?
Advanced 1 g7 231 1 Modify
2 o7 11 Al awEdk 1 todify
3 o7 11 Ulawbdk 1 Mo dify
4 t3btcp 1 todify
5 3Budp i Moty
° g 1 "
7 g7 29AnnexA 1 hdodify
g g7 11 AlawBdk 2 hlodify
< 5 = o7 11Ul awhbdk 2 Iladify 3
@ ® Internat

The different codecs and their indices are specified in the Media Capability section.

Check that either capability set 1 or capability set 2 has the correct codecs defined and that they
are defined in the preferred order of use. (The Vega will use the first codec in the list that it can

negotiate.)

If not, in the Media Capability Sets section, in Capability Set 2:

> Select Modify
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Modify Capability Set 2

Capabhility Set 2
Mame |vnice+t3BUdp |

Capability Indices  |1.6.236.33 |

In the Capability Set 2 section, in Capability Indices
» List the codec indices in the required order (comma separated)

> select Ml and then click “here” to return

On the left hand side menu select SIP and scroll down to the Media section

3 Vega 50/ 6x4 Online Configuration - Microsoft Internet Explorer |'._||'E|fz|
File Edt Wew Favorites Tools Help :f
QBak - O - [# [@ @0 P search P Favorites £ v m = 3
fiddress @] hbtp: (172,109,199 vsFrame?sid=- 183536 35408frame _id=52 v| B3 5o

HostMame  this_hosthame

gﬂ'ef"‘m IF Address  172.19.1.89
Ned? P Address  0.0.0.0
Lger Mame admin

& Unsaved & Unapplied Changes

-~ -~
Management 1 Media 1
Loggin Capability Set @

Maintenance

POTS Redi .
Dial Plan egistration
DSP Show SIP Registration Show Registration
L1 . . =
Media Enable Registration
Tones Register Message Reguest URI Port |506EI |
SIP - Expiry Tirme (seconds)
Users fode ®narmal O dnsswy
0 i : : 3
05 Statistics haximum Murnber of Redistrars
Supp.Semvices - }
Advanced Minimum “alid Response 200
Timeout {ms) 5000
SIP Registrar  Enable IP/DNS Mame  Port Chg?
1 0 0.0.00 5060 Modify
o
Add | Delete

» Set Capability Set = 2 (if capability set 2 contains the preferred list, or 1 if capability set 1
contains the preferred list)
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8. Configure Authentication

Note: everything in this section should be skipped for Standalone / non-proxy installations

In some systems — to ensure that only authorised devices are allowed to set up and clear calls —
SIP authentication is used. If authentication is used, it is typically required on the SIP
REGISTRATION, INVITE, ACK and BYE messages.

For authentication, a user-name, and a password can be configured. In the Vega, the user-name
is constructed from three parts

Username Prefix, Username and Username Suffix
each of which may be configured with alphanumeric values.

The values for user-name and password entered here must match the values that have been
configured as the authorisation user and password in the proxy.

For example, to set up a single authentication username ‘VegaGateway’ and password ‘VegaPass’
which can be used for all calls:

» On the left hand side menu select SIP
» Scroll down to the bottom to the SIP Authentication Configuration section

e

Tones

sip Interface D 3301

Users Maximum Calls |26

QoS Statistics

Supp.Services

Advanced SIP Token Configuration
SIF Token

SIP Authentication Configuration
SIP Authentication

SIP Response-Cause Mapping Configuration

SIP Response-Cause Wapping
Advanced SIP Configuration

| Advanced SIP

£ > w

@ Etror on page. 0 Internet

> Select SIP_Authentication
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2} Yega 50 x4 Online Configuration - Microsoft Internet Exploren

File Edit Yiew Favorites Tools  Help :,
QBack - ) ¥ 2] (0 S search T Faverites € L= = 3
address |ﬂj hkbp:ff172,19, 1,99 vsframetsid=- 183536 35408 rame_jid=52 V| Go

HostMame  this_hosthame
IP Address 172.19.1.98

IP Address no.oan

User Name  admin

/i\, Unsaved & Unapplied Changes

art
qe'?s“e

Ead
Management | SIP » Authentication
Loggin
Maintenance SIP Authentication Users
LAN Del? User Enable HEE e R el sername B Password Source Chg?
POTS Prefix Suffix Usermame
Dial Plan [FTH Il 0 no prefix no suffix 01 0 userd] IF:EIED
DSP O 2 0 no prefix no suffix 0z 02 userd? |IF:0202 Modify
Media | 3 0 no prefix no suffix 03 03 userd3  |IF:0203 Modify
Tones 0 4 0 no prefix no suffix 04 04 userdd  |F:0204 Modify
SIP b )| 5 0 no prefix no suffix 05 05 userds |F:0205 Modify
Users 0 & 1] no prafix no suffix 06 06 usel5  IF:0206 Modify
QoS Statistics Add | Delete

1%l

I=
=
o
i
=
[x]
[
=

upp.Services

Save

Log off

Help £

Feboot System

DB

ﬁ Internet

For User 1
> Select Modify
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SIP » Authentication > User

SIF Tokens
Taken Yalue
1 unit1
2 01

Modify SIP Authentication User

SIP Authentication User 1
Enable [

Username Prefix none ¥
Username Suffix none
Usernarme 01
Password userll

Source IF:0201

| Submit_‘

Tick Enable

Check Username Prefix = none
Check Username Suffix = none
Set Username = VegaGateway
Set Password = VegaPass

Set Source = IF:.*

select Ml and then click “here” to return

YVVVVYVYVY

SIP » Authentication

SIP Authentication Users

Del? User Enable LEememef UEmee Username Euil Password Source Chg?
Prefix Suffix sername

a 1 1 no prefix no suffin VegaGateway VegaGateway VegaPass P Modify

| 2 0 no prefix no suffix oz 0z uged2  IF:0202 Modify

| 3 0 no prefix no suffix 03 03 userd3  IF:0203 hodify

0 4 0 no prefix no suffix 04 04 userdd  IF:0204 Modify

O & o] no prefix no suffix 05 05 userds  IF:0205 Modify

O & 0 no prefix no suffix 5 N[5 userds  IF:0206 hodify

Add | Delete
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9. Configure Registration

Note: everything in this section should be skipped for Standalone / non-proxy installations

Typically trunking interfaces do not need to register with a SIP proxy. SIP registration was
designed for end users to register themselves with the SIP proxy. Trunking gateways potentially
support millions of end users and so typically the presence and capabilities of the gateways are
manually configured into the SIP proxy.

For telephony to SIP calls, the SIP proxy is usually manually configured to accept calls from the
Vega
o the dialled number of the call is placed in the request URI by the Vega

For SIP to telephony calls the Proxy must send the call to the Vega with a request URI of the
format iiiittt..t@Host Name or IP address of Vega

e where 1iii is the interface number through which the call is to be made (Vega interface
0201 .. 0224), and

e where ttt..t is the telephone number for the Vega to dial

In some circumstances the SIP proxy does demand that the Vega registers with it. If registration is
required, see 14.1 “Configure Vega FXO reqistration”
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10. Configure POTS parameters

For the FXO ports it is necessary to configure the Vega to recognise the cadence of the ring tone
that it will receive to indicate that there is a new call for it, also the impedance of the FXO interface.

See also 14.2 “Configure caller ID per FXO port” to configure the Vega to source a caller ID
based on the FXO interface that the call arrives on.

Configuring Ring Cadence Detection for FXO ports

The Vega FXO ports are alerted to new telephony calls arriving by the PBX or CO switch
presenting ringing voltage to the Vega. The Vega needs to have parameters adjusted to configure
the detector for the ring tone(s) it is going to be presented with.

Configure the FXO ring cadence detector so that it detects incoming ring cadences correctly:

> On the left hand side menu select POTS
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2} Yega 50 x4 Online Configuration - Microsoft Internet Exploren

File Edit Yiew Favorites Tools  Help -:,'
QBack - ) ¥ 2] (0 S search T Faverites € L= = 3
Address | ] hetp:/172.19.1,99)vsframe?sid=-18353635408f rame_id=5 v| B so
Hosthame  this_hastname
5“.631“ IP Addrass 172.19.1.99
yed? IP Address  0.0.0.0
User Name  admin

Media
Tones
SIP
Users

QoS Statistics

1%l

upp.Services

/i\, Unsaved & Unapplied Changes

Ea
| POTS Configuration
Port Configuration
Part Caller Ty Hardware
) D Enabled FXS D Layer 1 Gain  profile
1 1 0 off gfl1AlawBdk O 1
2 1 0 off gfllAlawbdk O 1
3 1 0 off gfi1AlawEdk O 1
4 1 0  off g7i1AlawGdk O 1
5 1 0 off gfllAlawGdk O 1
B 1 0 off gfl1AlawBdk O 1

POTS Interface Profiles
POTS Interface Profiles

Interfaces Chg?

==
===3
===53
===
===¢3

==

8]

:

difs

T EEEE
= =2 = = =]
e e & = =
el =l (= = =

SUpp.>ervices
Advanced
Advanced POTS Configuration
|
< | @
@ ® Internat
» Select Advanced POTS
» Scroll down to the FXO Configuration section
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Vega 50 6x4 Online Configuration - Microsoft Internet Explorer

File Edit View Favorites Tools Help :;'
@Back ~ ) [ [2] (0 S search o Favorites £ - i = 3
Address \@j http:f172.19. 1,99 vsframesid=-18353635408f rame_jd=32 V| d G0

Host Mame  this_hostname

g\\’eam IP Address  172.19.1.99
ed? |P Address  0.0.0.0

UserMame  admin

& Unsaved & Unapplied Changes

Rihg Generation Parameters

Loggin Del? ID  Name Fre-guency  Repeat  Ringl On  Ringl Of  Ring2 On  Ring2 OF  Ring3 On  Ring3 OF  Chg?

Maintenance 00 1 Extemal 50 1 400 200 400 2000 0 500 Modify

LAN o z Internal a0 ] 2000 4000 2000 4000 1} 500 Iodify

PPTS b [0 3 belcorer! 20 1 400 400 900 400 400 3500 Modify

Dial Plan Delete | _Add |

DSP —elete |

Media Hardware Profile Configuration

Tones Profile Hookflash Debounce Hookflash Line Loop Current Loop Current Loop Current

Sip D Time Time Reversal Iredleree Bireak Time Delay Clige

Users 1 70 200 ] default 0 300 9000 hodify

QoS Statistics Delete | _Add |

Supp.Services

Advanced FXO Configuration

Hardware Profile Configuration

Prlo[;flle %lzlorroe&t HDTDIII{TT:Sh ||5j:2‘ Ea_Srlz:iri;!Lz:.l-nE Rel_\flzfsal DISEDDI’r]cI’:;CtS E;Toif %?3::&" Impedance Rg;zgse g;l:ar:zg Maore Chig?
etect Seize Timeout Detect Time Delay Cause

_ D w0 @ 0 1 oo CTRZI 0 T ===

Delete | Add
Rehaat System 2

< | v

[

8 Internet

» In the FXO Configuration Hardware Profile Configuration section select Modify
» Scroll down to the FXO ring-detection parameters section
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VYega 50 6x4 Online Configuration - Microsoft Internet Explorer IZIIEIEI
I

File Edit \Wiew Favorites Tools  Help :f
@oBack - ) - [ [2) (n S search v Favorites ) i = 3
Address @ http:ff172,19, 1,99 vsframe?sid=- 18353635408 frame_jd=32 4 | Ga

Host Mame  this_hostname

IP Address 172.19.1.89
IP Address 0.0.0.0
User Name  admin

/ﬂ Unsaved & Unapplied Changes

At
qeﬁ*ﬁ“e

A RINGDACK Fresent ¥ V.
Management Impedance CTR21 v
Loggin FPort Release Delay (s) |D |
Maintenance
LAN Port Mot Released Cause Code |34 |
POTS « | Enable Tone Detection O
Dial Plan Ringback Tone Profile |1 |
DSF Busy Tone Profile |1 |
Media i
Tones Congestion Tone Profile |1 |
SIP Disconnect Tone Profile |1 |
Users Call Connection Time |SD |

QoS Statistics

upp.Services

L

=
=
<
o
=
[x]
fu:]
=

FX0O ring-detection parameters

Shartest Ring On Time |
Save
Longest Ring Off Time
Log off -
(bm)

Help ]

Rehoat System - @ |

< | & v
@ D Internet
» set Shortest Ring On Time = length of shortest ring in the incoming ringing voltage
cadence
» set Longest Ring Off Time = length of longest silence in the incoming ringing voltage
cadence

> select Ml and then click “here” to return

Table 1 lists the standard values to use in the UK and USA.

Table 1. Ring tones parameters

Country UK USA
Ring tone values Longest silence 2000ms 4000ms
Shortest ring 400ms 2000ms

(for other countries see the country tones document on the technical documents page of
www.VegaAssist.com)

Version 0.6 16 November 2006 Page 34 of 51
For use with Vega 50 6x4 FXO — SIP version 11.02.07.5_S011 or greater. © 2006 VegaStream Ltd.



Now configure the interface impedance
» Scroll down to the FXO Configuration section again

Yega 50 x4 Online Configuration - Microsoft Internet Exploren

File Edit “iew Favorites Tools Help :;'
@sack ~ ) [¥ [2 (n O search rFavorites €2 LY = B
Address ‘ﬁj hktp:ff172,19, 1,99 vsframe?sid=-1835363540&frame _id=32 "| ao

Host Kame  this_hosthame

gt\’eam IP Addrags 17218108
Ned? P Address  0.0.0.0

UserMame  admin

/& Unsaved & Unapplied Changes

Ring Generation Parameters

Loggin Del? ID  Mame Fre-quency Repeat Ringl On  Ringl Of Ring2On  Ring2 Of Ringd On  Ring3 Of  Chg?
Maintenance 1 1 Extemal 50 1 400 200 400 2000 0 500 Modify
e o 2 Internal a0 ] 2000 4000 2000 4000 1} 500 Modify
P?J b [0 3 belcorer 20 1 400 400 400 400 400 3500 hodify
Dial Plan Delete | _Add |

DSP _Delete |

Media Hardware Profile Configuration

Tones Profile  Hookflash Debounce Hookflash Line Loop Current Loop Current Loop Current

SIP D Tirme Tirmne Reversal Ittt Bireak Time Delay Clige
Users 1 70 200 ] default 1} 300 9000 Modify
QoS Statistics _Delete | _Add |

1=

=
=
o
o
=
x]
]
=
7]

upp.Service

FXO Configuration

e Hardware Profile Configuration
Loop Early Eatly Line  Line DTMF . Part Port Mot
Frafile Hookflash 7 . Force Ringback
Log off D Current T Line  Seize  Reversal Disconnects Holdoff Prasent Impedance Release Released More Chg?

Datect Seize Timeout Detect Tirne Delay Cause
Help — 0 200 0 30 0 1 4000 1 CTR21 0 34 :::
Delete | Add

Rehoat System =
< =N v
@ & Internet
> In the FXO Configuration Hardware Profile Configuration section select Modify
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ega 90 6x4 Online Configuration - Microsoft Internet Explorer

File Edit \Wiew Favorites Tools  Help :,
Qsak - O - ¥ & o D search <7 Favarites €8 [0 @ 3
Address @ hktp:ff172.19,1,99vsframe?sid=- 18353635408 rame_jd=32 w '—) Ga

Host Mame  this_hostname

5“23‘“ IF Address  172.19.1.99
Ned? IP Address  0.0.0.0

User Name  admin

/ﬂ Unsaved & Unapplied Changes

M M
Management | POTS » Advanced > FX0 > 1 1
Loggin
Maintenance FXO parameters
LAN Loop Current Detect |D |
POTS “ " Hook Flash Time (ms) (200 |
Dial Plan R —— 0
ar INe SBIZE
DSP i
Media Early Line Seize Timeout (=) |3D |
Tones Line Reversal Detect F
SIP Farce Disconnects
Users DTMF Hold-off Time (ms) 4000 |
QoS Statistics Ringback Present
Supp.Services
Supp.Serices Irmpedance CTR21 »
Advanced =
FPort Release Delay (s) |D |
Port Mot Released Cause Code |34 |
Enable Tane Detection il
Ringback Tone Profile |1 |
i
Busy Tone Profile |1 |
Congestion Tone Profile |1 |
< |3 hiccanmest Tana Denila [ | »
@ D Internet
» In the FXO parameters section, select the appropriate Impedance for the lines that the
Vega FXO ports are to be connected to:
- CTR21 (typically Europe)
- 600R (typically US)
- 900R
Subirmit N N
> select 4| and then click “here” to return
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11. Save Changes

The changes to the configuration must be saved and activated. This is carried out as follows:

» On the left hand side menu select Save

Microsoft Internet Explo x|

@ Save Configuration Changes?
Cancel |

1 and after the configuration has been saved click “here” to return

> On the left hand side menu select __Fe2 SysEm |

> Select :

Reboot

() Force calls to clear
&) Wyait for system idle Block new calls

[ Feboot ” Cancel ]

> select [PReboot |

The Vega will reboot and once back on-line, it will be ready to take its first call.
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12. Archive Vega Configuration

Once configured it is recommended that the configuration is archived to an external server.

To do this check that the tftp address is configured to point to a tftp server (in the LAN page), then
on the left hand side menu select Advanced, and scroll to the CLI Command section:

CLI Command

| Submit |

» inthe text entry box type “PUT tftp:initial cfg.txt”.

> Select Ml

This will send all the configuration parameters to the tftp server and save them as the file
“initial cfg.txt”. (Note: you may want to choose a unique name rather than
“initial cfg.txt”, especially if you are configuring more than 1 unit).

The Vega configuration can be archived to an ftp server instead of a tftp server by configuring the
ftp server address in the LAN page and then typing the CLI command

“PUT FTP:initial cfg.txt”. (Again a unique name can be used in place of

“initial cfg.txt”)

If the ftp server requires a login username and password:

» On the left hand side menu select LAN
» Scroll down to the FTP Parameters section

FTP Parameters

Server P 0.0.0.0]
FTP Port 21

FTP Ping Test

FTP Timeout 20
Anonymous Login [v]

FTP Username whatewer
FTP Passwaord ssssssss
LAN Profile 1

Abort Socket Before Closing IF]

Use DHCP Settings From
Interface

1

» Un-tick Anonymous Login
» Set FTP Username = <ftp username>
» Set FTP Password = <ftp password>
» Check Use DHCP Settings From Interface = 1
> select Ml and then click “here” to return
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13. Technical Support

Support information can be found on the VegaStream Support web site www.VegaAssist.com

If you require help from VegaStream support personnel, please use the serial interface or telnet
into the unit, log in and then type:

» show support

» sip monitor on

» log display on

Carry out the interaction you want explained, then copy the information provided by the Vega and
e-mail it to support@VegaStream.com together with your question.

Notes:
1. If the screens do not appear as indicated, check that Java is enabled on your web
browser (Tools>internet options>Security, select internet and custom level and configure
Microsoft VM Java permissions and Scripting parameters as indicated below.

Security Settings Security Settings e |
Setkings: Settings:
[#% Fant dowrlaad | @ Scripting -]
O Disable Active scripting
{® Enable ) Disable
(O Prompt (& Enable
[Sj riicrosaft v J O Frompt
E] Java permissions Allowy paste operations via script
O Custom ) Disable
O Disable Java (& Enzble
(& High safety _ ) Prompk
O Low safety Scripting of Java applets
O Medium safety () Disable J
& Miscellaneous (& Enable
@] Access data sources across domains O Prompt -
[ ~ rﬂ Uheme B skbmmbin ki
« | LI_I " | >

2. Where there are multiple sections — each with a Ml button — entries must be made

to one section at a time, and those entries confirmed by the Ml button before the

next section is altered. Each Ml button only confirms entries for its own section.

Any changes in other sections will be discarded when the Ml is pressed.

3. Loss of audio mid call — consider reducing the selection of available codecs (see section
6). Some equipment, when presented with multiple codecs, may try and switch codec
mid-call. Vegas do not support changing codec type mid-call.

4. Mismatched audio codecs. Use SIP monitor on to identify this. If the codecs of the
endpoints are mismatched this will be reported as error 606 “No matching media”. To
rectify, enable the appropriate audio codec (see section 6).

5. Outbound calls from the Vega send the INVITE to “Default Proxy Host Name/IP” with the
request line: “INVITE sip: <dest TEL:>@Default Proxy Host Name/IP".
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14. Advanced configuration

Vega 6x4 gateways have further configurable parameters that may be desirable to configure in
order to fully integrate into the attached infrastructure. Some are configurable through the web
browser; others must be configured through the Command Line Interface.

14.1 Configure Vega FXO registration

Note: everything in this section should be skipped for Standalone / hon-proxy installations

For trunking gateways, registration may be used to tell the Proxy that the Vega exists and is
available to take calls. The number of ‘users’ that need to be registered by the Vega gateway on
the SIP Proxy will depend on the Proxy’s requirements, typically however, only a single registration
is required.

For example, to register a single user with a username “VegaGateway123”

» On the left hand side menu select SIP
» Scroll down to the Registration section
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2} Yega 50 x4 Online Configuration - Microsoft Internet Exploren

File Edit Yiew Favorites Tools  Help :,'
(}Back A > | Iﬂ @‘] o ):'Search ' Favorites & L1 @ 3
address |ﬂj hkkp: /172,19, 1,99 vsframe?sid=-13353635408f rame_jid=52 v| &0

HostMame  this_hosthame
IP Address 172.19.1.98

IP Address no.oan

User Name  admin

/i\, Unsaved & Unapplied Changes

art
qe'?s“e

e s
Management Registration
Loggin Show SIP Registration Show Registration
Maintenance Enable Registration
LAN Register Message Request URI Port |EDED |
Dial Blan wpiry Time (seconds)
DSP Mode ®narmal O dnssry
Media Maximum Mumber of Registrars
Tones Minirmurn ‘alid Response
SIP Timeout (ms) 5000
Users
QoS Statistics SIP Registrar Enable IP/ONS Mame Fort hg?
. 1 0 0.0.00 5060 @
Supp.Services —— -
elete
Advanced -
SIP Registration Users Configuration
SIF Registration Users
|
SIP Session Timers Configuration
¥ SIP Session Timers
< | & v
@ Cane ﬁ Internet
For SIP Registrar 1:
> Select Madify
SIP » SIP Registrar 1
SIP Registrar 1
Enable [F]
IP/IDNS Mame (0000 |
Part 5060 |
)
S|
» Set IP/DNS Name = IP or DNS name of SIP registrar or machine

proxying for the registrar

> select Ml and then click “here” to return
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In the SIP Registration Users Configuration section
» Select SIP Registration Users

EIP > Registration

SIP Registration Users

Del? Usar Enable On Username Username Built  Authentication

Prefix Suffix SR Usermame  User Index Cli?
00 1 0 0O noprefix nosufix 01 01 Vegaéa;teway Wadify
a =z 0 02 noprefix  no suffix 0z 0z 2-02 hodify
J 3 0 03 noprefix no suffix 3 3 3-03 todify
| 4 0 04 noprefix  no suffix 04 04 4-04 hdodify
[ s 0 05 noprefix  no suffix 05 05 5-05 hodify
1 & 0 08 noprefix  no suffix 05 05 G- 06 hdodify

_Add | Delete |

For registration user 1:

> Select Modify
» Scroll down to the SIP Registration User 1 section
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2} Yega 50 x4 Online Configuration - Microsoft Internet Exploren

File Edit Yiew Favorites Tools  Help :;
@bk ~ O - [¢ [ o ) search 57 Favorites 42 ~ = 3
Address |ﬂj hkkp: /172,19, 1,99 vsframe?sid=-13353635408f rame_jid=52 "| Go

Hosthame  this_hostname

su.eam IP Address  172.18.1.99
yes? IPAddress  0.0.0.0

User Name  admin

/i\, Unsaved & Unapplied Changes

Management “ $IP Authentication Users °

Logygin Uszar Enable Uspername Usemame 1o mame Built Pazzword Source
refix Suffix Username

Maintenance 1 1 no prefix  no suffix VegaGateway VegaGateway VWegaPass  [F.*

LAN 2 0 no prefix no suffix 02 02 userd2  |F:0202

POTS 30 noprefix  no suffix 03 03 userd3  IF:0203

Dial Plan 4 0 noprefix  no suffix 04 04 userld  |F:0204

DSP a 0 no prefix  no suffix 05 03 usedd  |F:0205

Media & 0 na prefix  no suffix 06 [2] userds  IF:0206

Tones

siP -

Users Modify SIP Registration User

QoS Statistics

SIP Registration User 1
Enable

Dn ]

Save Usermame Prefix none v
Lag of Userame Suffix m

Jzermame m ) |

Help £
Authentication User IndexC 1-YegaGateway ¥ D 0
Feboot System =

| 2 ~
ﬁ Internet

1%l

I=
=
o
i
=
[x]
[
=

upp.Services

DB

In the SIP Registration User 1 section
» Tick Enable
» Check Username Prefix = none
» Check Username Suffix = none
» SetUsername = VegaGatewayl23

If Authentication will be needed for REGISTRATION
» Set Authentication User Index = required Authentication User
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Modify SIP Registration User

SIP Registration User 1

Enahle

Dn 01

Username Prefix naone ¥

Username Suffix none

Username VegaGateway123
Authentication User Index | 1-‘“egaGateway ¥
[ Submit |

| ——

» Select Ml and then click “here” to return

» Save and reboot to activate

Recommended: Configure the Vega to reject calls with cause code 38 if registration fails (this
allows calls to be re-presented in the dial plan immediately, rather than having to wait for the SIP
timeouts to find that the SIP proxy is not available to handle the INVITE)

On the left hand side menu select Advanced, and scroll to the CLI Command section:

CLI Command

| Submit |

Enter
» set_advanced.sip.invite.registered=1

> Select Ml and then close the CLI command window

See the ‘Introduction to Vega dial plans’ document on the step by step configuration page of the
www.VegaAssist.com web site to learn how to create a redundant dial plan to handle calls when
the Vega is not registered.
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14.2Configure caller ID per FXO port

Where caller ID reception is not enabled on the Vega FXO ports, or where the line will not supply
caller ID information to the Vega, the Vega can be configured with telephone numbers on a per
port basis which it will present as the Caller ID when calls are made from those ports.

Configuring caller ID on FXO ports

For this example set the caller IDs to 1344784900 ...

Firstly disable the prefix and suffix entries (that would apply to every port) — these can be used to
apply a common prefix and/or suffix to all caller IDs, but it is typically easier to configure the whole

caller ID on a per port basis:

» On the left hand side menu select POTS

POTS Configuration

Port Configuration

F;E]n Enabled Fx3 Cﬁ:l]ler Layer 1 GT:in szglmaere Interfaces Chg?
1 1 0 off g7ilAlawBdk O 1 === Mdodify
2 1 0 off g7ilAlawBdk O 1 === Mdodify
3 1 0 off gfilAlawBdk O 1 === Modify
4 1 0 off gfilAlawBdk O 1 === Mdodify
5 1 0 off g7 1AlawBdk 0O 1 === Modify
5 1 0 off g7 1AlawBdk 0O 1 ===> Modify

POTE Interfase Profiles
POTS Interface Profiles

Advanced POTS Configuration
Advanced POTS

In the POTS Interface Profiles section
> Select POTS Interface Profiles

POTS Interface Profiles Configuration

POTS Interface Prefiles
Frofile Caller IDv Caller ID DTMF  DTMF dial Line busy

D type wait  dial digit  timeout cause Elif?

1 off G000 # 5 17 Mladify

2 off G000 # 5 34 Madify
Delete | Add |

In the POTS Interface Profiles section, Profile ID 2,
> Select Modify
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POTS > Profile 2

Modify Profile

Profile 1D 2

Line busy cause 34

Caller |D wait 5000

Caller ID type off A

DTMF Termination Char #

DTMF Dial Timeout b
Username prefix MLUILL
Username suffix unitl

» Check that Username prefix=NULL
» Set Username Suffix=NULL

> select Ml and then click “here” to return

Now for each FXO POTS port set up the full caller ID:

» On the left hand side menu select POTS

POTS Configuration

Port Configuration

F;Bn Enabled Fx3 C?[I]Ier Layer 1 GTaxin H;l:jl\%rlzre Interfaces Chg?
1 1 0 off gfilAlawBdk O 1 === / Modify
2 1 0 off gfilAlawBdk O 1 ===x| Modify
3 1 0 off gfilAlawBdk O 1 ===:| Modify
4 1 0 off gfilAlawBdk O 1 ===: \ Modify
5 1 0 off gfilAlawBdk O 1 ===:> |odify
5 1 0 off gfilAlawBdk O 1 ===:> Mdodify

In the POTS Configuration section, for Port ID 1
> Select Modify
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POTS > Port1

Modify Port
Part ID 1

Enable

Layer 1 g7 11 Alawhdlk v
Caller [D off hd

Fr5 0

Tx Gain 0|+

Hardware profile 1

Interface Configuration
Port Index  Interface Profile  Interface I DM Ring Index  Usermame  Usernumber  Chg?

1 2 0201 0201 2 portt 01 I adify
Delete | Add

In the Interface Configuration section
> Select Modify

POTS > Port1 > Interface 1

Modify Interface

Port Index 1
Interface Prafile 2
Interface 1D nzm
Ring index 2
dn 0201
LIsername portl
Usernumber m

POTS Interface Profiles
Profile  Caller ID Caller ID DTMF dial  DTMF dial  Line busy

D type wait digit timeout cause
1 off G000 # g 17
2 off 6000 # 5 34

In the Modify Interface section

» Set the numeric part of Caller ID in dn
For this example dn=1344784900

» Set the textual part of Caller ID in Username
If a space is required in the username, enclose the whole username in quotes, e.g. “Steve Hight”

Repeat for all other FXO ports.
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14.3 Configure Vega to dial out from a free FXO port

In some cases the Proxy will just want to use the Vega as a trunking gateway, and so will want the
Vega to just find a free FXO interface to route the calls through.

The configuration below will:
e Take calls from the Proxy and route them to the first free port found in the group 0204,
0203, 0202 and 0201

Set up a Call Presentation Group to send calls to interfaces 0204, 0203, 0202, 0201
Set up a dial plan to take calls with a prefix 8888 and route them to the Call Presentation Group
virtual interface (i.e. the first free interface 0204, 0203, 0202, 0201

» On the left hand side menu select Dial Plan
» Scroll to the Call Presentation Groups Configuration section

Call Presentation Groups Configuration
Call Presentation Groups

In the Call Presentation Groups Configuration section
» Select Call Presentation Groups

Call Presentation Groups

&2l Sequence Destination PEEHIEE LT
Del? Presentation Mame Enable Interface =1 ; Timeout Destination Cause Chg?
Wode Timeaut :
Group Action  Aftempts
[F 1 default 0O 1001 round_robin 180 Hang Lp 8 17 ( Modify
Add | Delete

Call Presentation Groups

Del? Call Presentation Group Destinations Chg?
[ 1 IF:06IIF:07 |IF:08)IF:020FAQF: 1 IF:12(IF:13 Modify
Add | Delete

In the Interface Configuration section
> Select Modify
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Call Presentation Group Configuration

Call Presentation Group 1

Marne default

Enable 0

Interface 100

Sequence Mode round_robin
Destination Timeout 180

Destination Timeout Action | Hang Up b

Max Destination Attempts |8
Cause 17

Call Presentation Group 1
Destinations C|IF:06|IF:07|IF:08|IF:08)IF; 10[IF:11[IF:12IF:13

In the Call Presentation Group 1 section
» Set Destinations = 0204|0203]0202]|0201

> select Ml and then click “here” to return

» Return to this page

Call Presentation Group Configuration

Call Presentation Group 1

Mame default

Enable 0

Interface 10m

Sequence Mode round_rahin
Destination Timeout 180

Destination Timeout Action | Hang Up hd

Max Destination Attempts (|5

Cause 17

Call Presentation Group 1
Destinations IF:0204|IF:0203)|IF0202|IF0207

In the Call Presentation Group 1 section
» Set Name = Find_free_FXO
» SetEnable=1
» Set Sequence Mode = Linear_up
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» Set Max Destination Attempts = 4
» Set Cause = 34

Submit |

> select and then click “here” to return

Call Presentation Groups
Call

Sequence Destination Dlesilciiion
Del? Presentation MName Enable Interface : Timeout
Mode Timeout .
Group Action
I 1 Find_free_Fx0 1 1007 linear_up 180 Hang Up
Add | Delete
Call Presentation Groups
Del? Call Presentation Group Destinations Chy?
[ 1 |F:0204|IF:0203|IF:0202IF:0201 todify
Add | Delete
» On the left hand side menu select Dial Plan
Dial Planner
Profiles
Del?  Profile I Enabled Mame Plans  Chg?
[F] 1 1 COutbound_to_LAR === Modify
il 2 1 Inbound_from_LAMN === Modify
Delete |\ Add |

In the Profiles section
> Select Add |

In the Profiles section, Profile ID 3

> Select Mo dify

Set Name = LAN_to_free FXO

select Ml and then click “here” to return

>
>
» Return and modify the dial plan

Dial Planner » Profile 3 » Plan 1

Modify Plan

Plan D 1

Profile 1D 3

MName new_plan
Source "TEL:<. . »<*"
Destination "IF:<1» TEL<2>"
Cost Index 0

Group 0-nogroup *

[

Generate Prefix katch ]

In the Modify Plan section

» Set Name = 8888 to _free FXO

» Set Source = IF:99..,TEL:8888<.*>
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» Set Destination = IF:1001,TEL:<1>
> select ﬂl and then click “here” to return

This will strip the leading 8888 and dial the rest of the number out from a free FXO port (specified
by the CPG group interface 1001).

Plans in this Prefile
Plan

Del? D Mame Srce Dest Cost Group Chg?
[] 1 B8B83 _to free FXO IF:3901 TEL:8888<.*= IF:1001 TEL:<1> 0O 0 Modify
Delete | Add

Remember to Save the changes.

Further details on these and other parameters may be found in the Vega Primer.

Contact Details
Email: support@vegastream.com
Web: http://www.vegastream.com

EMEA Office USA Office
VegaStream Limited VegaStream Inc.
Western Centre 6200 Stoneridge Mall Road
Western Road 3rd Floor
Bracknell Pleasanton
Berks RG12 1RW California 94588
UK USA
+44 (0) 1344 784900 +1 925 399 6428
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